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8 Diffusion

Diffusion is an important social process. Administrators are interested in the

diffusion of information and opinions, producers seek the adoption of new

techniques and products, and all of us have a vivid interest in not acquiring

contagious diseases. Diffusion processes are being studied in the communication

sciences, social psychology and sociology, public administration, marketing, and

epidemiology.

In this chapter, we present diffusion processes from a network point of view.

Diffusion is a special case of brokerage, namely brokerage with a time dimension.

Something - a disease, product, opinion, or attitude -  is handed over from one

person to another in the course of time. We assume that social relations are

instrumental to the diffusion process: they are channels of social contagion and

persuasion.

If personal contacts are important, then the structure of personal relations is

relevant to the diffusion process and not just the personal characteristics which

make one person more open to innovations than another. We will investigate the

relation between structural positions of actors and the moment at which they

adopt an innovation.

8.1 Example

Educational innovations have received a lot of attention in the tradition of

diffusion research. Our example is a well-known study into the diffusion of a new

mathematics method in the 1950s. This innovation was instigated by top

mathematicians and sponsored by the National Science Foundation of the USA as

well as the U.S. Department of Education. The diffusion process was successful

since the new method was adopted in a relatively short period by most schools.

The example traces the diffusion of the modern math method among school

systems which combine elementary and secondary programs in Allegheny County

(Pennsylvania, USA). All school superintendents who were at least two years in

office were interviewed. They are the gatekeepers to educational innovation

because they are in the position to make the final decision. The researchers

obtained data from 61 out of 68 superintendents, 51 of whom had adopted by

1963 (84%).

Among other things, the superintendents were asked to indicate their

friendship relations with other superintendents in the county with the following

question: Among the chief school administrators in Allegheny County, who are

your three best friends? The researcher analyzed the friendship choices among the

38 interviewed superintendents who adopted the method and were in position at

least one year before the first adoption, so they could have adopted earlier.

Unfortunately, the researcher did not include the friendship choices by
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superintendents who did not receive any choices themselves; they are treated as

isolates. In the original network, some friendship choices are reciprocated and

others are not (ModMath_directed.net) but we will use the symmetrized

network (ModMath.net), which is depicted in Figure 1. A line in this network

indicates that at least one superintendent chooses the other as his friend.

Figure 1 - Friendship relations among superintendents and year of adoption.

As you may infer from Figure 1, adoption started in 1958 and all schools under

investigation had adopted by 1963. The year of adoption by a superintendent’s

school is coded in the partition ModMath_adoption.clu: 1958 is class (time)

one, 1959 is class (time) two, etc. The first adopter (v1) is a superintendent with

many contacts outside Allegheny County but few friends within the county. He is

a ‘cosmopolite’ and cosmopolites usually are early adopters but they are often too

innovative to be influential in a local network.

Application

For a first visual impression of a diffusion process, draw the sociogram in the

order of adoption time (Figure 1). In order to do this, the adoption time of vertices

must be specified in a partition (e.g., ModMath_adoption.clu). Draw the

sociogram with vertex colors defined by the partition (Draw>Draw-Partition or

Ctrl-P) and select the command Layers>in y direction to arrange the vertices by

Draw>Draw-Partition
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adoption time. Note that this procedure is only available when a network with

partition is drawn.

In most cases, the vertices are not optimally placed within each level. To

improve their positions, use the Optimize layers in x direction command. Play

around with the options (Forward, Backward, Complete) until you obtain a layout

without lines which cross vertices with which they are not incident. In Figure 1,

this was not possible because superintendent v8 is connected to too many vertices

in his adoption class, so we decided to move him a little away from the ‘column’

of his class.

Sometimes, it helps to rearrange the vertices within a layer by hand. If you do

this but you want to be sure that the vertices within a class remain aligned,

activate the option y in the Fix menu of the Draw screen. Now, you can move

vertices horizontally only.

The layers are drawn in the y direction: from the top down. In Figure 1,

however, time flows from left to right on the X axis, which is the standard way to

represent time. We obtained this figure by rotating the standard layout of layers

by 90 degrees. Select the command Rotate 2D from the Options>Transform

submenu in the Draw screen. Type 90 in the dialog box captioned Angle in

degrees and press the OK button.

8.2 Contagion

Information is important to the diffusion of new opinions, products, and the like.

In most societies, the mass media are central to the spreading of information, so

we ought to pay attention to mass communication. Several models have been

proposed for the process of mass communication, one of which is consistent with

a network approach: the two-step flow model. According to this model, mass

communication consists of two phases. In the first phase, mass media inform and

influence opinion leaders. In the second phase, opinion leaders influence potential

adopters within their communities or social systems.

Network models of diffusion focus on the second phase, assuming that

opinion leaders use social relations to influence their contacts. Social ties are

thought to be important because innovations are new, hence risky. Personal

contacts are needed to inform and persuade people of the benefits associated with

the innovation. Note that salient social relations for spreading information may be

different from relations used for persuasion. The relations most commonly

investigated are advice and friendship relations.

Basically, network models see diffusion as a process of contamination, just

like the spread of an infectious disease. Therefore, passing on an innovation via

social relations is called social contagion. This perspective is backed by the

empirical fact that many innovations diffuse in a pattern which is similar to the

spread of infectious diseases. First, an innovation is adopted by few people but

their number increases relatively fast. Then, large numbers adopt but the growth

rate decreases. Finally, the number of new adopters decreases rapidly and the

Layers>Optimize layers

in x direction

Fix>y

[Draw screen] Options

>Transform>Rotate 2D
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diffusion process slowly stops. This diffusion pattern is characteristic for a chain

reaction in which people contaminate their contacts, who contaminate their

contacts in the next step, and so on.

Figure 2 - Adoption of the modern math method: diffusion curve.

The adoption of the modern math method is represented by a diffusion curve in

Figure 2. The X axis shows the moment of adoption and the Y axis represents the

prevalence of the innovation, which is the percentage of all interviewed

superintendents who have adopted the modern math method by that year. Note

that prevalence is represented by cumulative percentages, that is, the sum of all

percentages of previous adopters: in 1958, 3 percent of the superintendents adopt

and in 1959 another 10 percent adopt, so the cumulative percentage of adopters is

13 percent in 1959.

Figure 3 - Diffusion by contacts in a random network (N=100).

The diffusion curve has the logistic S-shape, which is characteristic of a chain

reaction. We find a similar curve when we take a random network and choose a

random vertex as a source of contamination (Figure 3). When we assume that a

vertex contaminates its neighbors at time one, who contaminate their neighbors at

time two, etc., we obtain the typical diffusion curve of Figure 4 (bold line). Note
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that the number of new adopters increases faster and faster in the first three steps

(red, orange, and yellow vertices) and that the absolute number of new adopters

decreases sharply after the fourth step (blue and light blue). This example

illustrates that contagion through network ties may explain the logistic spread of

an innovation or a disease. If we find a diffusion curve which does not have the

typical S shape, it is quite unlikely that network ties are important to the diffusion

process and diffusion is probably propelled predominantly by other forces such as

mass media campaigns.

Figure 4 - Diffusion from a central and a marginal vertex.

When contagion drives the diffusion process, the structure of an information or

contact network conditions the diffusion of information, innovations, diseases, et

cetera. Using the measures introduced in previous chapters, some broad

hypotheses are easily derived:

(a) in a dense network an innovation spreads more easily and faster than in a

sparse network,

(b) in an unconnected network diffusion will be slower and less

comprehensive than in a connected network,

(c) in a bi-component diffusion will be faster than in components with cut-

points or bridges,

(d) the larger the neighborhood of a person within the network, the earlier

s/he will adopt an innovation,

(e) a central position is likely to lead to early adoption,

(f) diffusion from a central vertex is faster than from a vertex in the margins

of the network.

The adoption rate is the number or percentage of new adopters at a particular

moment.

The speed of the diffusion process is measured by the adoption rate, which is the

number or percentage of new adopters at a particular moment. It is easy to see
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that the adoption rate is higher when an innovation spreads from a central vertex

than when it starts at a marginal vertex. Figure 4 shows the diffusion curves for

the diffusion from the central white source vertex in Figure 3 (bold line) and from

the peripheral light blue vertex which is linked to one dark blue vertex (dotted

line). Both curves have the typical S-shape but it takes considerably more time for

a diffusion to reach half or all of the population when it is triggered by a vertex in

the periphery.

The hypotheses presented above highlight the impact of network structure on

the diffusion process. We should note, however, that personal characteristics and

the type of innovation also influence the rate of adoption. The perceived risk of

an innovation, its perceived advantage over alternatives, and the extent to which

the innovation complies with social norms that govern the target group determine

whether it is adopted quickly, reluctantly, or not at all. A risky innovation, for

instance, will diffuse slower regardless of the network’s density and connectivity.

Application

The diffusion curve is constructed from a simple frequency tabulation of adoption

time, which is displayed by the Info>Partition command (Table 1). The table

shows the cumulative relative frequencies which are plotted on the Y axis in the

chart of Figure 2. The class numbers represent the moments which are displayed

on the X axis. Note that this is a basic statistical procedure, which may be

executed in any statistical software package or spreadsheet.

Table 1 - Adoption in the modern math network.

Class Freq Freq% CumFreq CumFreq% Representative

1 1 2.63 1 2.63 v1

2 4 10.53 5 13.16 v2

3 10 26.32 15 39.47 v6

4 12 31.58 27 71.05 v16

5 8 21.05 35 92.11 v28

6 3 7.89 38 100.00 v36

Sum 38 100.00

8.3 Exposure and thresholds

In the previous section, we assumed that every person is equally susceptible to

contagion. One infected neighbor is enough to get infected; friendship with one

adopter is enough to persuade someone to adopt. This is not very realistic because

some people are more receptive to innovations than other people. There are two

different ways to conceptualize the innovativeness of people, namely relative to

the system and relative to their personal networks: adoption categories and

threshold categories.

Adoption categories classify people according to their adoption time relative

to all other adopters. These typologies are very popular in product marketing and

a standard classification distinguishes between the early adopters (first 16 percent

who adopt), the early majority (next 34 percent), the late majority (next 34

Info>Partition
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percent), and late adopters or laggards (last 16 percent to adopt). In order to

classify people, we only have to know their adoption time. Then, we can simply

mark the first 16 percent of all adopters as early adopters, etc. This classification

is useful for marketing purposes because it enables the marketing manager to

identify social and demographic characteristics of early adopters which help to

target them efficiently in marketing campaigns for a new product.

In the modern math example, early adopters are characterized by higher

professionalism ratings and more accurate knowledge about the spread of

educational innovations in their district. In addition, the superintendents who

adopted early were not recruited from the school staff but they came from

outside.

We will concentrate on the second approach to innovativeness, threshold

categories, which considers the personal network of actors. The network model

of diffusion is based on contagion: an adopter spreads the innovation to his or her

contacts. In other words, the adopter exposes his or her contacts to an innovation.

It is quite natural to assume that the chance that a person will adopt increases

when s/he is linked to more people who already have adopted, that is, when s/he

is exposed to more adopters. Hearing about the benefits of an innovation from

different sources will persuade a person to adopt. The amount of exposure varies

over time and among individuals, which explains that some people adopt early

although they are not close to the sources in a diffusion process. The exposure of

a person is expressed as a proportion so it may be the thought of as a chance to

adopt.

The exposure of a vertex in a network at a particular moment is the proportion of

its neighbors who have adopted before that time.

Figure 5 shows the modern math network with the exposure of vertices in 1959

indicated by vertex size and by the numbers in brackets. Note that invisible

vertices have zero exposure: none of their neighbors adopted in or before 1959.

Eight out of the ten superintendents who adopted in 1960 had friends among the

1959 adopters, so they were exposed. Clearly, superintendent v10 was most

exposed: two of his three friends adopted in 1959, so his exposure was 0.667 at

the end of 1959. Not all exposed superintendents, however, adopted in 1960:

superintendents v16 and v23 adopted in 1961 and v28, v29, and superintendent

v32 adopted in 1962. They were not less exposed than several superintendents

who adopted immediately in 1960, for instance, v8, v9, v13, and v15, so we

would expect them also to adopt in 1960. They contradict the simple contagion

model which presupposes that all actors need the same amount of exposure in

order to adopt.

In fact, statistical analyses of diffusion data do not always find a systematic

relation between exposure and adoption. Either this means that exposure and

contagion are irrelevant to adoption or people need different levels of exposure

before they adopt. If we pursue the latter option, we assume that some people are

easily persuaded, e.g., they need only one contact with an adopter, while others
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are talked into adopting an innovation with difficulty. Some people are more

susceptible than others, which is an established fact for media exposure as well as

social exposure.

Figure 5 - Adoption (vertex color) and exposure (in brackets) at the end of 1959.

In the network model of diffusion, the innovativeness of a person is perceived as

his or her threshold to exposure. An individual’s threshold is the degree of

exposure which s/he needs in order to adopt an innovation. Now, differences

between individual thresholds may account for the fact that only part of the

people adopt who are equally exposed.

The threshold of an actor is his or her exposure at the time of adoption.

In our example, four superintendents (red vertices in Figure 5) adopted the new

math method in 1959. They exposed thirteen superintendents (blue vertices) to

their experience with this method and eight of them adopted the method in the

next year. Five superintendents, however, adopted two or three years later. Why?

Each of the exposed superintendents who adopted after 1960 has one or two

friends among the colleagues who adopted in 1960 or 1961. By the time they

adopted, these friends had also adopted, so their exposure was higher than at the

end of 1959. According to the threshold hypothesis, their exposure had not

reached the required threshold in 1959 but it did in 1960 or 1961. This explains

why they adopted later.

At the end of 1959, for example, one out of the four friends of superintendent

v23 had adopted the modern math method, so his exposure was 0.25. In 1960, one
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more friend (v15) adopted and his exposure increased to 0.5. Then,

superintendent v23 adopted, so we assume that his threshold was 0.5 or

somewhere between 0.25 and 0.5.

We should note that individual thresholds are computed from the diffusion

network ‘after the fact’: they are predictions with hindsight and they are not very

informative by themselves. It is important to make sense of them or to validate

them, which means that they should be associated with other indicators of

innovativeness, for instance, adoption time or personal characteristics.

Thresholds indicate personal innovativeness, a lower threshold means more

innovative, and we expect innovative people to adopt an innovation earlier than

non-innovative people. Therefore, individual thresholds must be related to

adoption time: innovative people have low thresholds and adopt early. If we find

such a relation, we obtain some support for the assumption that individual

thresholds indicate innovativeness.

At least to some extent, however, a positive relation between adoption time

and individual thresholds is an artifact of the contagion model which we use. The

first adopters cannot be exposed to previous adopters, so their thresholds are zero

by definition. Within the network of adopters, the last adopters are very likely to

be connected to previous adopters, so their exposure and thresholds are high at

the time of adoption. When measurement of adoption time is restricted to a small

number of moments, this will automatically produce a relation between individual

thresholds and adoption time.

Therefore, it is important to compare individual thresholds also to external

characteristics of the actors which usually indicate innovativeness. In general,

innovativeness and low thresholds are supposed to be related to broad media use,

many cosmopolitan contacts (contacts outside your local community), a high

level of education, and high social economic status.

Application

Let us compute exposure levels in the modern math network at one moment, for

instance, at time two, 1959 (see Figure 5). The procedure consists of several

steps, which illuminate the calculation and exact meaning of the exposure

concept. We assume that the network is undirected. If not, symmetrize it

(Net>Transform>Arcs->Edges>All and remove any multiple lines).

First, we identify the adopters in the network at the selected time, which is

1959 or time two in our example. Make a binary partition from the adoption time

partition where adoption times one and two get score one (adopted) and others

become zero (not-adopted yet) with the Partition>Binarize command, selecting

classes one through two in the dialog boxes. In Figure 5, the adopters are red and

the non-adopters are light blue. Then turn this partition into a vector in order to

use it for computation (Partition>Make Vector or simply press Ctrl-V).

Second, compute the number of adopters in each actor’s neighborhood with

the command Operations>Vector>Summing up Neigbours>Input or Output. A

dialog box appears, which asks whether a vertex should be included in its own

Partition>Binarize

Partition>Make Vector

Operations>Vector

>Summing up Neigbours
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neighborhood. Answer No. Pajek does not count the number of neighbors but it

sums the class numbers of the neighbors of a vertex. Since we use a binary

partition in which an adopter has class number one and a non-adopter has class

number zero, this sum is equal to the number of adopters in the neighborhood. It

is a little trick, but it works.

Third, the number of adopters in the neighborhood of a vertex must be

divided by its total number of neighbors because we defined exposure as the

percentage of neighbors who have adopted. The division can be done in the

Vectors menu. The vector we just made must be selected as the first vector in this

menu (Vectors>First Vector). Next, we must make a vector with the total number

of neighbors of a vertex. Recall that the degree of a vertex in a simple undirected

network specifies the number of neighbors of a vertex, so we can make a degree

partition in the usual way (Partition>Degree>Input) and turn it into a vector

(Partition>Make Vector - do not use the Normalized Indegree vector!). This

vector must be used as the second vector in the Vector menu (Vector>Second

Vector). Finally, we divide the number of adopters in a vertex’s neighborhood by

the total number of neighbors with the Vectors> Divide First by Second

command. Now, we obtain a vector with the exposure of vertices at the end of

1959 (time two).

The calculation of exposure consists of a considerable number of steps. If you

want to compute exposure at several points in time, you have to repeat these steps

over and over again. This is not very efficient, so Pajek contains the possibility to

execute a number of steps in one command, which is called a macro. A macro is a

file which consists of a list of commands which are executed when you ‘play’ the

macro in Pajek. We prepared the macro exposure.mcr which you can execute

by clicking on the Play command in the Macro menu and selecting the file

exposure.mcr which is located in the directory with the data accompanying this

chapter. When you open this file, Pajek starts to execute the commands. It

displays the dialog boxes which allow you to select the first time of adoption

(Select clusters from), which is one in our example, and the time for which you

want to compute exposure (Select clusters from 1 to), for instance time 3. Upon

completion of the macro, several new partitions and vectors have been created

and the last vector contains the exposure at the requested time.

Now that we have computed the exposure at one time, let us turn our attention

to the calculation of thresholds. The threshold of a vertex is the proportion of its

neighbors who have adopted before ego does, so we have to divide the number of

prior adopters among the neighbors of a vertex by the size of its neighborhood.

The computation of thresholds is fairly simple once you realize that the number

of neighbors who have adopted prior to ego is equal to the indegree of ego in a

directed network in which each line points from an earlier adopter to a later

adopter. Figure 6, for instance, shows the modern math network if edges are

replaced by arcs which point to later adopters. If social ties are used to spread the

innovation, the arcs represent the direction of the spread. Note that ties within an

Vectors>First Vector,

Second Vector,

Divide First by Second

macro
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adoption class are omitted because they are not supposed to spread the

innovation.

In Pajek, we can change an undirected network, e.g., the modern math

network, into a directed network with all arcs pointing from an earlier adopter to

a later adopter with the commands in the Operations>Transform>Direction

submenu. The commands are located in the Operations menu, so you need a

network and something else, namely a partition which specifies the classes to

which the vertices belong. There are two commands: Lower->Higher and

Higher->Lower. The first command replaces an edge in an undirected network by

an arc which points towards the vertex with the higher class number. In our case,

the partition contains adoption time classes so the Lower->Higher command

produces arcs towards later adopters. This command issues a dialog box asking

whether lines within classes must be deleted. In a diffusion network, we do not

want to have lines within adoption classes normally, so answer Yes. Now, we

obtain the network shown in Figure 6. Applied to a directed network, the

Direction procedure selects the arcs which conform to the selected option (lower

to higher or higher to lower).

Figure 6 - Modern math network with arcs pointing towards later adopters.
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Now, we can simply compute the thresholds of all vertices in the diffusion

network by dividing the indegree of vertices in the transformed directed network

by their degree in the original undirected network provided that both networks do

not contain multiple lines or loops. Select the vector with normalized indegree in

the directed network as the first vector in the Vectors menu, select the

corresponding vector for the undirected network as the second vector, and divide

the first by the second to obtain a vector with the individual thresholds. Make

sure that a division of zero by zero (no neighbors) yields zero in the

Options>Read/Write menu.

8.4 Critical mass

Some diffusion processes are successful because almost everybody in the target

group adopts the innovation, for instance, the modern math method was adopted

by 51 out of 61 superintendents in Allegheny County within a period of 6 years.

Diffusion, however, may also fail because too few people adopt and spread the

innovation. Once again, a biological metaphor is illuminating: a bacteria may

either succeed to overcome the resistance of the human body and develop into a

disease, or it does not gain the upper hand and it is oppressed and finally

eliminated by antibodies. The spread of a disease has a critical limit: once it is

exceeded, the bacteria multiplies quickly.

The critical mass of a diffusion process is the minimum number of adopters

needed to sustain a diffusion process.

In the diffusion of innovations theory, a similar limit is hypothesized to exist. It is

called the critical mass of a diffusion process and it is defined as the minimum

number of adopters needed to sustain a diffusion process. In the first stage of a

diffusion process, outside help is needed, e.g., an advertisement campaign, but

once a sufficient number of opinion leaders have adopted, social contagion fuels

the process and causes a chain reaction which ensures wide and rapid diffusion.

Then, no more outside input to the diffusion process is required.

The critical mass of a particular diffusion process is difficult to pinpoint, so it

is hard to prove that it exists and when it occurs. Recall that the two-step flow

model combines contagion with external events. We need detailed information

about the effects of external events, such as media campaigns, versus the effect of

social contagion on the diffusion process to know when critical mass is reached.

Only afterwards, we may evaluate whether a diffusion process was successful or

not. We present some approaches which try to overcome this problem.

There is an empirical rule of thumb which tells us something about the

number of people who will adopt an innovation eventually. In many diffusion

processes, a particular phenomenon occurs when the innovation has been adopted

by 16 (or 10 to 20) percent of all people who will adopt eventually: the

acceleration of the adoption rate decreases although the adoption rate still

Net>Partitions>Degre

>Input

Vectors

>Divide First by Second
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increases in absolute numbers. This is known as the first second order inflection

point of the S-curve.

In the modern math network, for instance, the number of new adopters

(adoption rate) rises from one to four from 1958 to 1959 (see the fourth column in

Table 2), which is three more than the number of adopters in 1958, so there is an

acceleration of three (see the fifth column in Table 2). In the next year, ten

superintendents adopt, which is an even larger acceleration, but in 1961 the

acceleration drops to two because the number of new adopters grows only from

ten to twelve; the number of new adopters still rises but it rises less sharply. In

1959, we may conclude, the acceleration of the adoption rate is highest and we

can see that 13 percent of all adopters have adopted (see the column ‘Cum% of

adopters’ in Table 2) as predicted by the rule of thumb.

Table 2 - Adoption rate and acceleration in the modern math diffusion curve.

Time Cum% of adopters Cum # of adopters Adoption rate Acceleration

1

1958 (1) 2.63 1 3

4

1959 (2) 13.16 5 6

10

1960 (3) 39.47 15 2

12

1961 (4) 71.05 27 -4

8

1962 (5) 92.11 35 -5

3

1963 (6) 100.00 38 -3

0

Because of this empirical relation between the first second order inflection point

of the diffusion curve and the final spread of an innovation, diffusion analysts say

that critical mass is attained when the diffusion curve reaches this inflection

point. In this approach, any diffusion process in which the adoption rate first

accelerates and then declines is thought to be driven by the chain reaction

characteristic for contagion models. Social contagion is assumed to take over the

diffusion process at this point, so we may conclude that the process has reached

its critical mass.

A similar argument has been made for the first order inflection point of the

logistic diffusion curve, which is the period with the highest adoption rate, that is,

the largest absolute increase in new adopters. Usually, the first order inflection

point occurs when approximately 50 percent of all eventual adopters have

adopted. In the modern math network, the highest adoption rate is twelve and it

was realized between 1960 and 1961. In this period, the percentage of adopters

rose from 39 to 71 percent.

We ought to realize that this approach completely presupposes the relation

between contagion and critical mass; it does not prove that critical mass occurs, it

merely assumes so. Nevertheless, it is useful for practical purposes. We may
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monitor the diffusion process and watch out for the moment in which the first

decline in growth acceleration occurs (but we should ignore incidental declines).

When it occurs, we may estimate the final number of adopters at about five to ten

times the number of adopters at the time of the largest increase because about 10

to 20 percent has adopted then. If this estimated number of adopters is not enough

according to our target, we can try to boost the diffusion process with additional

media campaigns and the like. If this leads to acceleration of the diffusion, the

critical mass becomes larger and the diffusion process will probably reach more

people in the end. We have no guarantee, however, that this will actually happen.

After all, we are working with a simple rule of thumb.

In another perspective, a diffusion process is assumed to attain its critical

mass when the most central people have adopted. Once they have adopted, so

many actors in the network are exposed to adopters that many individual

thresholds have been reached and an avalanche of adoptions occurs.

Betweenness-centrality seems to be associated with critical mass in particular.

Targeting the actors with highest betweenness-centrality is a good strategy for

launching an innovation. In general, the position of the first adopters in the

network is relevant to the diffusion process. If the first adopters are central and

directly linked, their neighbors have higher exposure rates, so they are more

likely to adopt.

Why does critical mass boost the diffusion of an innovation? On the one

hand, the reason may be purely quantitative: once a sufficient number of well-

connected people have adopted, enough people are exposed to the innovation to

adopt, after which even more people are exposed. This is the mechanism we

described for the case that the central actors adopt. On the other hand, reaching

the critical mass has been thought of as a qualitative change to the system,

namely, a sudden lowering of individual thresholds. During the diffusion process,

individual thresholds may be lowered as a consequence of the rate of adoption in

the entire social system. People are supposed to monitor their social system. If

they perceive wide acceptance of an innovation, they feel confident or even

obliged to adopt it. Lower thresholds lead to easier adoption, so the diffusion

process strengthens itself and it will most probably not wither away.

The lowering of thresholds is expected to occur particularly when actors are

interdependent with regard to an innovation. New communication technology

products, e.g., buzzers or SMS, are a case in point. When more people have one,

their benefits and value increase. The first adopters can reach few people with the

new communication products but the late majority can contact many more users.

This kind of innovation is called an interactive innovation. Even in the case of

non-interactive innovations, such as the modern math method, the qualitative

mechanism may be operative. Superintendents may be persuaded to adopt the

new method because they know that most of their peers have adopted, regardless

of the number of adopters in their circle of friends.

A threshold lag is a period in which an actor does not adopt although s/he is

exposed at the level at which s/he will adopt later.
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The lowering of thresholds when critical mass is attained in the diffusion process

may explain the occurrence of a threshold lag, i.e. a period in which the exposure

has reached the individual threshold but the individual does not adopt. In this

case, adoption occurs after the critical mass is reached, and the individual’s

threshold is lowered. In the modern math network, superintendents v28 and v29

reached the level of exposure at which they would eventually adopt in 1960

because all of their friends had adopted by that year. However, they did not adopt

immediately in 1961. There is a delay of one year, which is their threshold lag.

Perhaps, the diffusion process reached its critical mass in 1961, which lowered

their thresholds and induced them to adopt in 1962.

There are, however, alternative explanations for threshold lags. External

events may also account for the adoption at the end of the lag, e.g., a media

campaign or another significant event. The launching of Sputnik I in October,

1957, for example, is known to have spurred a wave of innovations in science and

education in the USA. In addition, practical circumstances may delay adoption,

e.g., a superintendent may want to use the new math method, but s/he does not

have the funds required to implement the innovation immediately.

Since threshold lags may point towards different factors which influence the

diffusion process, it is interesting to investigate them. If they coincide with

external events, it is likely that these events have an impact on the diffusion

process. In contrast, if a media campaign does not coincide with the end of

relatively many lags, it is probably not very influential.

Application

The absolute adoption rates and their acceleration can be calculated from the

frequency tabulation of adoption times which we discussed in Section 8.3. The

absolute growth or adoption rate is just the number of new adopters between two

moments, e.g., ten superintendents adopt the modern math method between the

end of 1959 and the end of 1960. In Table 3, adoption rates are placed between

the moments because they reflect the change between two measurements. The

acceleration of the adoption rate at a particular moment is the difference between

the adoption rate directly before and after this moment: subtract two successive

adoption rates. In 1959, the acceleration is six, because ten schools adopted in the

year after the end of 1959 and four adopted in the year before. It is easy to spot

the moment in which the acceleration starts to decrease while the absolute growth

(adoption rate) is still increasing.

Table 3 - Fragment of Table 2.

Time Cum% of adopters Cum # of adopters Adoption rate Acceleration

1

1958 (1) 2.63 1 3

4

1959 (2) 13.16 5 6

10

1960 (3) 39.47 15 2

Info>Partition
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When we define the critical mass as the first moment at which the most central

vertices have adopted, we may simply calculate the betweenness centrality of the

vertices and check at which time all or most of the central actors have adopted.

We advise to compute betweenness-centrality in the undirected network, so

symmetrize a directed network first. List the most central vertices with the

Info>Vector command by entering a positive number in the dialog box captioned

Highest/lowest or interval of values. You can check their adoption time in the

adoption time partition or in the layered sociogram (see Section 8.1). In our

example, the most central superintendents (v8, v13, and v12) are found among the

adopters in 1960 or 1959 (v5), so critical mass was reached in 1960. Note,

however, that not all central actors have adopted then: the fifth (v36) and sixth

(v32) most central superintendents adopted as late as 1963 and 1962.

For the calculation of threshold lags, it is important to note that a vertex

reaches its threshold when all prior adopters in its neighborhood have adopted. In

the modern math network, for instance, superintendent v28 reached his threshold

of 0.67 in 1960, when superintendent v8 adopted. At the end of 1960, all prior

adopters in his neighborhood had adopted (superintendents v5 and v8). The third

contact in his friendship network, superintendent v29, is irrelevant to the

threshold of v28 because s/he adopted at the same time as v28. The threshold lag

is calculated as the difference between the time of adoption of an actor (his or her

class number in the adoption partition) and the maximum adoption time of his or

her neighbors which is lower. We have to subtract one from the threshold lag if

we consider exposure at one moment to cause adoption at the next moment. The

threshold lag of v28 is equal to 1962 - 1960 - 1, which is one year.

In Pajek, the last contact of a vertex to adopt prior to this vertex is easily

found in the directed network which we introduced to calculate thresholds. When

all lines point from earlier to later adopters, the neighbor with the highest

adoption time on the input side of a vertex is its closest predecessor. The

computation, however, of thresholds includes some tricks which we do not want

to discuss here, so we prepared a macro (Threshold_lag.mcr) which you can

use to obtain threshold lags. When you play this macro (see Section 8.3), some

new networks, partitions, and vectors are created. The last vector contains the

threshold lags.

In the modern math network, we find threshold lags only for superintendents

v28 and v29 (one year lag). This small number of lags does not suggest that

external events or critical mass influenced the diffusion process. Most vertices

have adopted right after one or more of their friends had adopted, which is in line

with the simple exposure model and the threshold model.

Net>Vector>Centrality>

Betweenness

Info>Vector

threshold lag.mcr
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8.5 Summary

Innovations and infectious diseases diffuse in a particular manner which is

represented by the typical S-shape of the diffusion curve. At first, few actors

adopt the innovation but the adoption rate accelerates. When 10 to 20 percent of

the actors have adopted, the acceleration levels off while the absolute number of

new adopters is still increasing, causing a sharp rise of the total number of

adopters. Finally, the number of new adopters decreases and the diffusion process

slowly reaches its end.

This growth pattern is typical for a chain reaction caused by contagion.

Therefore, network models approach diffusion as a contagion process in which

personal contacts with adopters ‘expose’ people to an innovation. They learn

about the innovation and their contacts persuade them to adopt. Once exposure

reaches their threshold for adopting the innovation, which depends on their

personal characteristics and on characteristics of the innovation, they will adopt

the innovation and start ‘infecting’ others. As a consequence, the network

structure and the positions of the first adopters in the network, who are usually

opinion leaders, influence the rate at which an innovation diffuses. This is a very

likely mechanism but it is difficult to prove that diffusion actually works this

way.

At a particular moment in time, a successful diffusion process is hypothesized

to reach a critical mass, which means that the diffusion process can sustain or

even accelerate itself without help from outside, e.g., media campaigns. Even

with hindsight it is not easy to pinpoint the moment when critical mass is reached,

but according to an empirical rule of thumb this happens when the innovation has

spread to 10 to 20 percent of the actors who adopt eventually. This is the first

second order inflection point of the S-shaped diffusion curve: the moment when

the adoption rate does not accelerate anymore although it is still increasing.

Alternatively, the critical mass may be placed at the moment when the most

central actors have adopted or when relatively many actors adopt although their

exposure is not increasing. In the latter case, the critical mass or external events

are thought to lower individual thresholds.

We are not sure whether critical mass occurs and whether it has the

hypothesized impact on the diffusion process. Ongoing research in the diffusion

of innovations tradition must clarify this matter. Nevertheless, the concept offers

some practical tools for monitoring and guiding a diffusion process.

In theory, knowledge about other people’s adoption without personal contact

may count as exposure too, especially in the case of status similarities. Knowing

that people with similar network positions have adopted although you are not

directly linked to them, may persuade you to adopt also. In this chapter, we have

presented contagion by contact only and not by status imitation. Structural

approaches to status and roles will be introduced in Part V of this book.
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8.6 Exercises

1 If we use a simple contagion by contact model without individual thresholds

and one source of contamination, which vertex is the source in diffusion

curve 1 and which vertex is the source in curve 2 in the network below?

a v8 is the source in curve 1 and v1 is the source in curve 2.

b v7 is the source in curve 1 and v2 is the source in curve 2.

c v6 is the source in curve 1 and v3 is the source in curve 2.

d v5 is the source in curve 1 and v4 is the source in curve 2.

2 In the network of Exercise 1, which vertex would you choose to introduce an

innovation, e.g., a new product? Justify your choice.

3 In the network of Exercise 1, the red vertices have adopted an innovation at

time one. Calculate the exposure of the remaining vertices by hand.

4 Take the situation of Exercise 3 as your starting point. At time two, vertices

v9 and v10 adopt. What can you say about the thresholds of vertices v10, v9,

and v8?

5 Take the situation of Exercise 4 as your starting point. If vertices v5, v6, and

v8 adopt at time three, which vertices have threshold lags?

a None of the three vertices.

b Only vertex v5.

c Vertices v5 and v6.

d All three vertices.

6 Considering your answer to Exercise 5, can you identify the critical mass of

this diffusion process? Justify your answer.

7 Estimate the total number of adopters from the following data on the start of

a diffusion process.
time 1 2 3 4 5 ….

cumulative number of adopters 21 74 251 635 1176 ….

54321
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8.7 Assignment

In a famous study, known as the Columbia University Drug Study, the diffusion

of a new drug (gammanym) was investigated. The researchers collected data on

the first subscription of this drug by physicians in several communities. In

addition, they investigated friendship ties and discussion links between the

physicians, asking them to name three doctors whom they considered to be

personal friends and to nominate three doctors with whom they would choose to

discuss medical matters.

The file Galesburg.net contains a network of friendship (blue) and

discussion relations (red) between 17 physicians who adopted the new drug in

Galesburg (Illinois) in the 1950s. The partition

Galesburg_adoptiontime.clu specifies the number of months since the

introduction of the new drug at which the physician first prescribed the drug. This

is considered to be their adoption time.

Analyze the diffusion process visually and numerically. Do you think the

innovation diffused by a simple contagion process or by a contagion process with

individual thresholds? Is it probable that external events or a critical mass effect

influenced the diffusion process?

8.8 Further reading

•  The example is taken from R.O. Carlson, Adoption of Educational

Innovations (Eugene: University of Oregon, Center for the Advanced Study

of Educational Administration, 1965). Friendship choices and year of

adoption are coded from the sociogram on page 19 of this book.

•  The Columbia University Drug Study was reported in J.S. Coleman, E. Katz

and H. Menzel, Medical Innovation. A Diffusion Study (Indianapolis: Bobbs-

Merrill, 1966). The data, however, are taken from D. Knoke and R.S. Burt,

‘Prominence’, in R.S. Burt and M.J. Minor (Eds.), Applied Network Analysis.

A Methodological Introduction (Beverly Hills: Sage Publications, 1983, 195-

222).

•  E.M. Rogers’ Diffusion of Innovations (New York: The Free Press, 1995, 4th

edition) offers a general overview of diffusion theory and research. He uses

the modern math case as an example (see pages 65-66 and Chapter 8).

•  T.W. Valente’s Network Models of the Diffusion of Innovations (Creskill, NJ:

Hampton Press, 1995) presents and evaluates different diffusion network

models.

8.9 Answers

1 Answer b is correct. Recall that the simple contagion model without

individual thresholds assumes that an adopter persuades his neighbors to

adopt at the next time, who transmit the innovation to their neighbors, and so

on. This means that the adoption time of a vertex is directly related to its
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distance from the source of ‘contagion’. If we assume that the source adopts

at time one, the cumulative percentage of adopters is 1 out of 10 (the number

of vertices) or 10 percent. This is correct because both diffusion curves start

at 10 percent. At time two, the neighbors of the source adopt. In the solid

line, 50 percent or five out of ten vertices have adopted at the second

moment. One of them is the source, so there are four new adopters who are

neighbors of the source. There is only one vertex in the network with four

neighbors, namely vertex v7, so this must be the source of the diffusion

process represented by the solid curve.

From the dotted curve, we can infer that two vertices adopt at time two, one

vertex adopts at time three, five vertices adopt at time four, and one vertex

adopts at time five. The source has two neighbors, so it can be vertex v2, v4,

v6, v3, v9, or v10. At distance two, it is connected to one vertex. This is true

for vertices v2 and v4 but not for the other possible sources. As you will see,

the diffusion process is identical whether it starts from v2 or v4, so the dotted

line may represent the diffusion from both vertices.

2 For optimal diffusion, you must choose the most central vertex in a network

because it exposes most vertices to the innovation. Vertex v8 is most central

and has the largest degree, so it is a good choice.

3 Vertices v1, v2, v4, and v6 are not directly linked to the adopters (v3 and v7)

in the network, so their exposure is zero. Vertex v9 is only linked to adopters,

so its exposure is maximal: 1.00. One of v10’s two neighbors is an adopter,

so its exposure is 0.5. One out of v5’s three neighbors is an adopter and two

of v8’s six neighbors, so they have an exposure of 0.33.

4 If we calculate the exposure of a vertex as the number of vertices which

adopted previously, the threshold of v9 and v10, who adopt at time two, is

equal to their exposure to the vertices which adopted at time one. Hence, the

threshold of v9 is 1.00 and the threshold of v10 is 0.5. The exposure of

vertex v8 is 0.33 at time two but this vertex does not adopt, so we may

conclude that its threshold is higher than 0.33.

5 Answer c is correct. At time two, vertices v9 and v10 adopt (see Exercise 3).

This changes the exposure of vertex v8: now half of its neighbors are

adopters. The new degree of exposure may surpass its threshold, hence v8

adopts at the next time. In contrast, the exposure of vertices v5 and v6 does

not change at time two because neither vertex is directly linked to v9 or v10,

so they could have adopted earlier. These vertices have threshold lags.

6 Threshold lags may be caused by critical mass. When a substantive number

of vertices adopt at a moment when their exposure does not increase, their

thresholds may be lowered due to critical mass. If we think two threshold

lags which are ended at time three is a substantive amount for this small

network, we may propose that the diffusion process reached its critical mass

at time two.

7 To estimate the total number of adopters, we need to know the number of

adopters at the first second order inflection point of the diffusion curve, that
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is, the last time that the acceleration of the adoption rate increases. Since this

moment often occurs when 10 to 20 percent of all adopters have espoused the

innovation, the total number of adopters may be estimated as five to ten times

this number.

Between successive measurements, the number of new adopters specifies the

adoption rate, which increases over all five moments (see the third row in the

table below). To calculate the acceleration, we must subtract the number of

new adopters by the number of new adopters at the previous moment. The

results are presented in the fourth row.

Now, we can see that the acceleration decreases after time three, so we

assume that time three represents the inflection point. The total number of

adopters may be estimated at five to ten times the (cumulative) number of

adopters at time three, which is five to ten times 251: 1255 to 2510 adopters.

time 1 2 3 4 5 ….

cumulative number of

adopters

21 74 251 635 1176

adoption rate (number

of new adopters)

21 53 177 384 541

acceleration 31 124 207 157
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